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FeatureCAM overview 

FeatureCAM is a CAD/CAM software suite that automates machining 
and minimizes programming times for parts on mills, lathes, and 
wire EDM. Unlike operations-based CAM systems, FeatureCAM 
generates toolpaths based on the features of the part, and 
automatically selects appropriate tools, determines roughing and 
finishing passes, and calculates feeds and speeds. The selections 
made can be based on the built-in machining knowledge that 
Delcam supplies 'out-of-the-box' with FeatureCAM, or from 
experience captured from your company, project or individual users' 
preferences. 

FeatureCAM includes five stand-alone modules: 
 2.5D Milling - 2.5D design and toolpath generation for 2- and 3-

axis mills.

 3D Milling - 3D surface modeling and 3-axis toolpath generation.

 3D Lite - a limited version of 3D milling.

3D Lite lets you mill only one surface per feature, but you 
can create multiple features. The strategies available in 3D 
Lite are Z-level rough, Parallel rough, Parallel finish, Isoline, 
and 2D spiral. 

 Turning - 2-axis design and toolpath generation for 2-axis lathes.

 Turn/Mill - Supports lathes with C and Y-axis milling capabilities.

 Wire EDM - 2- and 4-axis wire EDM toolpath creation.

The following add-on modules are also available: 

 RECOGNITION - 3D surface and solid import and the recognition
of 2.5D features from solid models. Accelerates making 2.5D and
turned parts from solid models.

 Tombstone - Multiple part manufacturing for horizontal or vertical
milling machines with indexers.
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 Solid Modeling - Solid modeling and tools for creating molds from
solid models.

 5-Axis Positioning - Manufacture 2.5D features from 5-axis
orientations.

 Native Import Modules - Native data can be read directly from
SolidWorks, SolidWorks Assemblies, Autodesk Inventor,
SolidEdge, Catia, NX, Pro-Engineer, and Step files.

 Machine Simulation - Modeling and simulation of a CNC machine.

 Advanced Turn/Mill (MTT) - Includes support for Turn/Mill in
addition to support for B-axis (5-axis positioning) and multiple
turret synchronization.

 Network Database and Licensing - Flexible product licensing allows
sharing FeatureCAM licenses across a network.

 5-Axis Simultaneous - Manufacture 3D features while changing
the tool axis.

Why creating toolpaths is so fast 
FeatureCAM has the unique ability to generate toolpaths and create 
NC code to run the machines with a minimum amount of user input. 

Traditional CAM systems are operations-based and require you to 
program every operation, one at a time, to create your part. 
FeatureCAM is feature-based; this means the part is created using 
features that describe that part, from simple holes, to complex 
pockets, to turned grooves. Machinable features contain information 
and rules describing how and where material removal should occur, 
cutting depths, whether to use climb cutting, whether to spot drill or 
center drill, and preferred machining strategies for roughing and 
finishing. This means that after you import or draw the part and 
identify its features, FeatureCAM automatically: 

 Selects the most appropriate tools and operations;

 Recommends machining strategies;

 Calculates speeds and feeds;

 Generates toolpaths and creates the NC code.

  You can customize this built-in 'intelligence' to your own style 
of cutting. 
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Finishing Basics 
Introduction 
 
FeatureCAM has wide variety of methods for finish machining parts. The strategy that is 
chosen will depend upon the part geometry, the type of stock and the available cutting tools. 
By choosing the most appropriate combination of strategy and tooling the user can greatly 
reduce the time taken to finish machine a part. The strategy chosen can also have a large 
influence on the surface finish achieved. 

Leave Allowance, Tolerance and Stepover 
 
When FeatureCAM is finishing a part, the main considerations are accuracy, surface finish, 
and speed of calculation. These are generally governed by the choice of tool, strategy, 
tolerance, and stepover. The tool and strategy choices largely depend upon the shape of the 
part that is being machined and will be covered in later modules. For now we will consider 
the leave allowance, tolerance, and stepover. 
 
Leave Allowance 
 
The Leave Allowance is the amount of material left on the part by the finish machining 
process. By default this is zero, i.e. the part will be finished to size. If the user wishes a 
positive leave allowance can be given, this will leave additional material on the part for 
subsequent processes - for example polishing or EDM (spark erosion). The leave allowance 
can also be negative; this will cut the part undersize. A negative leave allowance is usually 
used when machining electrodes for EDM, in such a case the leave allowance will be set to 
the required spark gap. 
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Tolerance 
 
The toolpaths produced by FeatureCAM consist of a number of straight line moves which 
move the tool across the surfaces to be machined. The length of the moves produced depends 
upon the tolerance value and the curvature of the surface being cut. The Tolerance is the 
maximum deviation of the tool from the surfaces being cut, for example a tolerance of 0.005” 
means that the tool will not deviate from the surface by more than 0.005” along the direction 
in which it is cutting. On a convex surface this will be the maximum amount of the 
permissible cut into the surface, on a concave surface it will be the maximum amount of 
material that will be left on the surfaces being cut. 
 
The Tolerance controls the accuracy to which the toolpath follows the shape of the work-
piece. With a coarse tolerance the toolpath is more faceted, as fewer moves are calculated for 
each profiling move. 
 
 
 
 
 
 
 
 
 
 
 
 
 

The effect of tolerance on a toolpath in a vertical plane (Parallel toolpath). 
 
 
 
 
 
 
 
 
 
 
 
 
 

The effect of tolerance on a toolpath in a horizontal plane (Z Level toolpath). 
 
Note  If a very fine tolerance is chosen for a roughing operation, it may take a long time to 
calculate the toolpath to an unnecessary accuracy. The optimum Tolerance value will depend 
upon the user balancing the required accuracy against the time taken to calculate the toolpath.  
 
It should also be noted that tolerance required will also depend upon the curvature of the part 
being machined. Where a surface has a large radius of curvature a smaller tolerance will be 
required to prevent faceting of the part. 
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Stepover 
 
The tolerance controls the accuracy with which the part is machined along the direction of 
travel of the tool. The distance by which the tool steps over between each tool pass will 
control the surface finish. In FeatureCAM, there are a number of ways in which the distance 
between passes can be controlled. It may be an explicit stepover either in the XY plane, along 
the surfaces, a vertical stepdown, or Z increment. Certain toolpath types allow the user to 
specify a scallop height. This is the height of the ridge in between the furrows left by the tool 
(equivalent to an Ra value).  
 

 

 
 
   Large Stepover     Small Stepover 
 
 
It is common practice to calculate toolpaths with a large tolerance and stepover while 
experimenting with different strategies. Once the strategy “looks right”, the user can then 
tighten up the tolerance and stepover for the final “manufacturing” calculation. This can save 
a great deal of time when working on large parts which will need to be finished to a high 
accuracy and surface finish.  
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Parallel Finish Machining 
Overview 
In this module, you will be introduced to the parallel finishing strategy. With this strategy a 
wide range of parts can be finish machined.  

Parallel Finish Machining 
In parallel finishing, the toolpath consists of a series of straight line passes across the part. 
The passes are equally spaced and parallel to each other at a specified angle to the X or Y 
axis. FeatureCAM varies the Z height of the tool to produce the finished part. Parallel 
finishing is also known as Raster finishing. 
 
• Open the part:  
 

C:\FeatureCAM\3-Axis\Finishing\Data\Die_Block.fm  
 
• Select the tool crib Die_Block_Start.fm_Tools_from_last_save 
• Select an Isometric view 
• Run a 3D simulation 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The part has been roughed out using a 1” endmill followed by a 0.5” ball nosed cutter. We 
will now generate an X Parallel finishing toolpath; this will remove the steps left by the 
roughing. This is known as a semi-finish operation.  
 
• Eject the simulation 
• Edit the feature srf_mill1 
• Select the Process tab 
• Uncheck the Z Level rough operation 
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• Click on Add new operation  
• Under Finishing Strategies select Parallel and click Finish 
• Edit the finish operation and select the Tools tab 
• Select a 1” Ball nose cutter, click Apply 
• Select the Milling tab and fill in exactly as below 

 
 
The leave allowance is telling FeatureCAM to leave 0.025” of material on the part for 
finishing. As this is a semi-finish operation, the surface finish is not important; this is why the 
stepover and tolerance have been increased to reduce the calculation time. As long as the 
tolerance is less than the finish allowance, the toolpath will not gouge the part. 
 
• Select a Top view and run a Centreline simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



FeatureMILL3D                                                                                                 3-Axis Finish Machining 

      Issue FeatureMILL3D 2012                                                                         3 

 
 
 
The toolpath should appear as shown above. The cutter is making parallel passes along X. 
We will now add a finishing pass to the operation. 
 
• Select the Process tab 
• Check the Z Level rough operation 
• Click on Add new operation  
• Under Finishing Strategies select Parallel and click Finish 
• Edit the new Finish operation and select the Tools tab 
• Select a 1” Ball nose cutter, click Apply 
• Select an Isometric view 
• Run a 3D RapidCut simulation using Play to next operation  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note how the semi-finish operation removes the steps from the roughing. This provides a 
more constant tool loading for the subsequent finishing operations which will give a better 
surface finish.  
 
You will see how the finishing pass in steep areas parallel to the cutting direction is giving a 
poor surface finish. We will now modify the finishing strategy to resolve this problem. 
 
• In the Part view double click on srf_mill 1 
• Click on the second Parallel in the tree view 
• Check Add perp. remach. pass 
• Click Apply and then OK 
• Run a 3D RapidCut simulation as before 
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The area that was poorly machined before has now been re-machined with a perpendicular 
pass to give an improved surface finish.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

It can be seen however, that there are areas where the 1” ball nose cutter is not able to finish 
into the corners. We will now add another Parallel finishing pass with a smaller cutter which 
will re-machine only those areas where the larger ball could not reach. 
 
• Eject the simulation 
• Edit the feature srf_mill1 
• Select the Process tab 
• Uncheck the Z Level rough operation 
• Click on Add new operation  
• Under Finishing Strategies select Parallel and click Finish 
• Edit the Finish operation and select the Tools tab 
• Select a 0.5” Ball nose cutter, click Apply 
• Click on the Parallel operation 
• Select the Strategy tab 
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• Fill in the form exactly as shown below 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Click on Apply and then Preview 
• Play the Centreline simulation 
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The inside corner areas of the part have be re-machined with the smaller cutter, only the 
area where the 1” cutter could not reach are machined. The initial pass is along the Y 
direction with a second pass being along X.  By setting the Steep slope angle to zero, we 
force FeatureCAM to machine the entire area in both directions. 
 
We will now look at a 3D simulation with tool colors turned on so we can clearly see the 
results of this additional process. 

 
• Eject the simulation 
• On the Options menu select Simulation 
• On the General tab check Tool colors 
• Click on Apply and OK 
• Run a 3D RapidCut simulation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The use of re-machining allows us to finish machine the bulk of the part using a relatively 
large cutter and then just finish selected areas with a smaller cutter. This provides a 
tremendous time saving over the alternative of using the smaller cutter with a small step-
over to machine the same part to the same surface finish.  

 
• Eject the simulation 

On the File menu select Close, DO NOT save the file 
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3D Spiral & Z Level Finishing 
Introduction 
In this section, Z Level and 3D Spiral finishing strategies will be applied to a model that 
consists of a combination of flat and steep areas, plus a pocket with vertical walls. In this 
exercise, applying either toolpath to the complete model without using would not be 
recommended. In general, Z Level finishing is more suited to parts with steeply inclined 
walls and 3D Spiral is better at gently curved shallow areas. By using Boundaries, we will 
limit the Z Level toolpath to the steep areas leaving the remaining shallow areas to be 
machined using the 3D Spiral strategy.  

 
• Open the file camera.fm 
• Select an isometric view 

 
 
 
 
We will first machine the steep areas of the part using a Z Level finishing toolpath. 
Generally, it is better to finish steep areas first and then go back to do the shallower areas. 
Otherwise, you risk making a full depth cut using the side of the tool when you approach a 
very steep or vertical wall. 
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Z level machining 
Z Level machining projects each tool track horizontally onto the component at fixed heights 
defined by the Stepdown; this also known as waterline machining. 
 

 
 
 
In Z level machining, a constant stepdown 
is used in the Z direction between each 
pass. As the component surface becomes 
shallow, the actual tool step over 
increases until it becomes non-existent on 
flat areas. For this reason it is a good idea 
to limit the toolpath to a slope boundary 
so that only the areas with a good surface 
finish are retained. By using a 
combination of 3D Spiral and Z level 
machining together with appropriate slope 
boundaries, the whole part can be 
machined to a good surface finish. 
 
 
 

 
• Select all of the surfaces 
• Create a new Surface milling feature 
• Click Next until you reach the New strategy page 
• Choose a single operation and click Next 
• Select a Z Level finishing strategy 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Finish and then OK 
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• Uncheck the roughing operation in the Part view 
• Run a Centerline simulation 
• Take a Left view 

The part is finished by a series of horizontal passes around the part which are spaced equally 
in the Z direction. As you can see in the image below this gives a varying surface finish on 
the part which is dependent upon how shallow the surface is. 

 
There are a number of ways in which we can remedy this problem. The first is simply to 
reduce the distance that the tool steps down between passes. 
 
• Eject the simulation 
• Edit the feature srf_mill1 
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• Select the Milling tab and set the Z Increment to 0.025” 
• Click  Apply and then OK 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Run a Centerline simulation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note the improved surface finish in the shallow areas. However we are now making 
unnecessary extra passes on the steeper areas which will waste time.  
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Another alternative is to use a variable stepdown, which is calculated based upon the desired 
surface finish. This is specified as a Scallop height. The scallop height is the maximum 
permitted height of the ridges or scallops between adjacent passes.  
 
• Eject the simulation 
• Edit the feature srf_mill1  
• Select the Milling tab and check Scallop height 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
• Click  Apply and then OK 
• Run a Centerline simulation 

 
 
 
 
 
 
 

Note how the stepdown now varies to maintain the maximum scallop height. It should also be 
noted that where a part goes from a shallow to a steep area in the same height region the 
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passes bunch together. We will now look at another, better way of controlling surface finish 
on surfaces with a wide variation in steepness. 
 
• Eject the simulation 
• Edit the feature srf_mill1 
• Select the Milling tab and uncheck Scallop height 
• Click on Z Level and then select the Slopes tab 
• Check Vertical only 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
We have now told FeatureCAM that we do not want to machine the shallow areas of the part. 
We can vary the area to be machined by changing the Minimum surface slope angle. By 
default this is set to 30 degrees indicating that any area of the part whose surface normal at 
the point of contact of the tool is inclined at less than 30 degrees to the vertical will not be 
machined.  
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Setting a Steep angle will also have the additional effect of causing FeatureCAM to see the 
edges of the part as steep areas. To avoid the tool dipping down the side of the block we also 
need to tell FeatureCAM not to take the tool outside of the stock. 
 
• Select the Stock tab and check Use stock dimensions 
• Set the Overcut % to Zero 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click  Apply and then OK 
• Run a Centerline simulation 
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The shallow areas are no longer being machined. This is eliminating those parts of the model 
where a poor surface finish would have resulted and also reduced the length of time taken for 
the machining process. We can now select a different method to finish those areas to give a 
good finish over the whole part.  

3D Spiral machining 
 
In 3D Spiral machining FeatureCAM initially calculates a boundary around the edges area to 
be machined. The toolpaths are then generated by offsetting the tool contact point on the 
boundary by a fixed Stepover across the surfaces to be machined. FeatureCAM defines the 
tool Stepover relative to the 3D surface shape providing consistency over both flat areas and 
steep sidewalls. The stepover is calculated in such a way that each successive pass of the tool 
is equi-spaced from the previous pass.  

 
• Uncheck the operation srf_mill1 in the part view 
• Select all of the surfaces 
• Create a new Surface milling feature 
• Click Next until you reach the New strategy page 
• Choose a single operation 
• Select a 3D Spiral finishing strategy 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click  Finish and 
then OK 
• Run a Centerline 

simulation 
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The first pass of the toolpath is following the rectangular outline of the flat surface. This pass 
is then offset inwards to produce the finished toolpath. 
 
The default tool is a ½” ball nosed cutter, this toolpath would be an inefficient way of 
finishing the flat area of the part. We will now modify the toolpath so that the outline of the 
first pass is not taken from the rectangular surface. 
 
• Eject the simulation 
• Edit the feature and click Part surfaces 
• Deselect the surface ig_48 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Click OK and Apply 
• Deselect the surface ig_48 
• Click on Check surfaces 
• Select the surface ig_48 
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• Click OK and Apply then OK 
 
We have selected this lower surface as a check surface to prevent the tool from gouging it. 
Otherwise the toolpath would go past the bottom of the edges of the steep surfaces by the 
radius of the cutter. 
 
• Run a Centerline simulation 

 
The toolpath is now starting at the outline of the selected surfaces and not wasting time 
cutting the flat area. This is still not a good toolpath, as it is starting at the bottom of the steep 
areas on the outside and cutting upwards. Notice also the way in which the toolpath rolls over 
the edge of the circular center pocket. We will now limit the toolpath so that it just cuts the 
shallow areas of the part. In this way we can use the previous Z Level toolpath for the steep 
areas. 
 
• Eject the simulation 
• Edit the feature and select the operation spiral3d 
• Select the Slopes tab 
• Check Horizontal only 
• Set the Maximum surface slope angle to 30 degrees 
• Click Apply and then OK 
 
We have now told FeatureCAM that we only wish to machine those surfaces whose surface 
normal at the point of contact of the tool is inclined at less than 30 degrees to the vertical. 
This will coincide with the boundary we set earlier for the Z Level finishing toolpath. 
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• Run a Centerline simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The toolpath is now confined to the shallow areas of the part. 
 
• Eject the simulation 
• Turn on the Z Level finish operation 
• Run a Centerline simulation 
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The two toolpaths now match at their edges finishing both the steep and shallow areas of the 
part. Due to the radius of the tool being used for the Z Level finishing toolpath it is not able 
to finish all of the way down the steep walls of the part. We will now change this. 
 
• Eject the simulation 
• Edit the Z Level finish operation 
• Select the Tools tab and pick a ½” Flat end mill 
• Change the End radius to 0.05” 
• Click Apply and then OK 
• Click Apply and then OK again 
• From the Options menu select Simulation 
• Check Tool colors 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
• Turn on all of the operations 
• Run a 3D simulation 
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• As an exercise use a 2.5D feature to finish the lower, flat face of the part 

Interleaved Z Level machining 
 
This strategy is a mixture of Z Level and 3D Spiral machining. Where the model is steep, 
Constant Z is used and for other areas, 3D offset is used. The method uses a default slope 
angle of 30 degrees to separate the steep and shallow areas. The two tool path passes are 
combined into one and reordered to reduce the number of times the tool lifts off the part.  
 
• Uncheck the 3D Spiral & Roughing operations 
• Edit the Z Level operation srf_mill1 
• Select Z Level and then the Strategy tab 
• Check Interleave spiral paths 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Run a Centerline simulation 
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Note how the 3D spiral and Z Level parts of the toolpath are combined to reduce air moves. 
The toolpaths are reordered so that the part is cut from the top down reducing the risk of user 
error which can occur with manual boundary creation. 

Horizontal and Vertical machining 
 
This strategy is also mixture of Z Level and 3D Spiral machining. Where the model is steep, 
Constant Z is used and for other areas, 3D offset is used. The method uses a default slope 
angle of 60 degrees to separate the steep and shallow areas. Unlike Interleaved Z Level, the 
two tool path passes are NOT combined into one. The resulting toolpath calculates more 
quickly than an Interleaved Z Level as FeatureCAM does not have to go through the 
combining and reordering processes. The finished toolpath should be checked carefully to 
ensure that the ordering is safe, particularly where a part contains vertical walls. The strategy 
works well on large parts with shallow walls where calculation time is critical. 
 
• Open the part Die_Block_Start.fm  
• Select the tool crib Die_Block_Start.fm_Tools_from_last_save 
• Select an Isometric view 
• Run a 3D simulation 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The part has been roughed out with multiple rough tools. We will now use Horizontal and 
Vertical finishing to complete the part.  
 
• Eject the simulation 
• Edit the feature srf_mill1 
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• Select the Process tab 
• Uncheck the Z Level rough operation 
• Click on Add new operation  
 
 
• Under New Strategy select Horizontal and Vertical 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Finish 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
FeatureCAM has made two new machining operations under the Horizontal + Vertical 
strategy. The first is the horizontal operation which will machine the shallow areas of the part 
with a 3D Spiral strategy. The second operation is a Z Level finish which will machine the 
steeper areas of the part. The Slope boundary number defines the cutoff between the steep 
and shallow areas. The Slope overlap allows the user to overlap the areas machined by the 
two operations to remove any witness marks at their meeting point. 
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• Set the Slope overlap to 0.5 degrees 
• Click Apply and then OK 
• Run a Centerline simulation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The part has been finished, however there are a number of improvements that could be made 
to the toolpath. We do not want to machine the upper flat surfaces; we can fix this by 
lowering the Z Start value for the 3D Spiral toolpath. The Z Level finish is machining down 
the side of the part; we can stop this using the stock Overcut %. Finally it would be better to 
machine the steep surfaces first then the shallow; we can do this just by changing the 
operation order in the Op list. 
• Eject the simulation 
• Select the first (3D Spiral) finish operation 
• Select the Milling tab 
• Set the Z Start value to -0.01” and then click Apply 
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• Click on the Horizontal & Vertical operation 
• Select the Stock  tab 
• Set the stock Overcut % to Zero then click Apply 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click Apply and then OK 
• Run a Centerline simulation 
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The 3D Spiral toolpath is now avoiding the upper surfaces and the Z Level does not finish the 
outside of the block. We will now turn on the roughing and reorder the toolpath sequence. 
 
•  Click on srf_mill1 and select the Process tab 
• Check the Z Level operation 
 
 
 
 
 
 
 
 
 
• Click Apply then OK 
• In the Operation list drag the operations into order 
 
 
 
 The two Roughing operations should be first, 
followed by the Z Level and then finally the 3D 
Spiral finishing. 
 
 
 
 
•  Run a 3D RapidCut simulation 
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Corner & Pencil Finishing  
Introduction 
 
Corner Machining includes 5 different types of strategy:  Pencil, Multi Pencil, Along, 
Across and Combo Along and Across. Pencil milling creates “single pass” machining along 
sharp internal corners while corner machining performs local re-machining of areas 
inaccessible to a larger tool. 
 
• Open the file Cowling.FM 
• Select an Isometric view 
 
This model contains a number of sharp 
inside corners. During this module we 
will see how to finish these with a 
smooth radius without having to model 
the radii into the part. On large complex 
models using the machining process to 
produce the radii on the model can give 
very significant reductions in the time 
taken for the designer to produce the 
model.  
 
 
By using a large tool to finish the bulk of the part and then picking out the corners later with a 
smaller tool, we can also make significant time savings in the finishing process. 
  
• Run a 3D RapidCut simulation 

 
 
 
The part has been roughed out and 
then finished using a 0.75” ball 
nosed cutter. This has been done so 
that a large finishing stepover can be 
used to finish the majority of the 
areas while still leaving enough 
material in the corners to produce 
0.125” fillet radii in the sharp 
corners on the model at the end of 
the machining process.  
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Pencil Finishing 
 
This operation produces single pass tool tracks along the intersection between sharp internal 
corners of the component surface. We will now create a pencil milling feature with the 
default values. 
 
• Eject the simulation 
• Uncheck the operation srf_mill1 in the part view 
• Select all of the part surfaces 
• Create a new Surface milling operation 
• Click Choose a single operation and click Next 
• Select Pencil strategy and click Finish 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Edit the feature 
• Click on Finish1 in the tree view 
• Select the Tools tab and pick a 0.25” ball endmill 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click Apply and then OK 
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• Unshade the part 
• Run a Centerline simulation 

 
The tool is making a single pass around all of the inside corners on the part. Both Corner 
Finishing and Pencil Milling strategies allow slope limits to be specified on the Slopes tab of 
the operation.   
 
Horizontal only limits the cutting to regions with a slope less than the user defined 
maximum surface slope.   
 
Vertical only limits the cutting to steep regions with a slope greater than user defined 
minimum surface slope.   
 
Limiting the regions where an operation is performed can solve the potential problems 
associated with the tool running up or down steep slopes. For instance the user could apply a 
stitch strategy to track across the steep areas and parallel strategy for shallow areas. Also a 
higher feed rate could be used on the shallow areas and a lower feed rate on the steep areas, 
which if applied first is more likely to be taking a heavy cut. 
 
• Eject the simulation 
• Edit the feature 
• Click on Pencil in the tree view and click on the Slopes tab 
• On the Slopes tab, Click Horizontal only 
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• Set the Maximum surface slope to 30 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Click Apply and then OK 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

We are restricting the toolpath so that it only cuts those areas on the model where the surface 
normal is inclined at less than 30 degrees to the vertical. 
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• Run a Centerline simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The toolpath is now only cutting the shallow areas of the model and avoiding the steep areas. 
 
• Eject the simulation 
• Edit the feature 
• Click on Pencil in the tree view and click on the Slopes tab 
• Click Vertical only and set the Minimum surface slope to 30 
• Click Apply and then OK 
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• Run a Centerline simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The toolpath is now only cutting the steep areas of the model and avoiding the shallow areas. 
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Corner Along Finishing 
 
All the Corner Finishing strategies, (except for Pencil) are corner re-machining techniques.  
In the illustration below a 60mm diameter tool would have left material in the corner between 
the points marked (2). The 30mm diameter corner finishing tool needs to remove the extra 
material between the points (1) and (2) on each side of the corner. 

 
• Check the surface milling feature named srf_mill1 in the Part View 
• Edit the pencil milling feature 
• On the Slopes tab set Slope limitations to None 
• Click Apply and then OK 
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• Run a 3D RapidCut simulation 
 
You can clearly see in the inside corners that there is material remaining between the areas 
finished by the 0.75” cutter and the 0.25” tool used in the pencil operation. 
 

• Eject the simulation 
• Uncheck srf_mill1 and srf_mill2 in the Parts view 
• Select all of the part surfaces 
• Create a new Surface milling operation 
• Click Choose a single operation and click Next 
• On the New strategy tab select Corner Remachining 
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• Click Next 
• Select Along and set the Previous tool diameter to 0.75” 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Nb. The Overcut percent figure defines the overlap of the Remachining operation over the 
original finishing operation. By default this is 5% which will overlap the two toolpaths 
sufficiently to eliminate any witness marks where the toolpaths meet. 
  
• Click Finish  
• Edit the feature.  Click on Remachine in the tree view 
• On the Slopes tab, Click Horizontal only and set the Maximum surface 

slope to 30 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click on finish1 in the tree view 
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• Click on the Tools tab and select a 0.25” ball endmill 
• Click Apply and then OK 
• Run a Centerline simulation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The shallow areas are being cleared of excess material from the outside inwards in a climb 
milling direction. There are multiple lift offs resulting in a lot of “air time”. The tool is also 
plunging directly into the remaining material. We can remedy both of these problems by 
modifying the leads and links. 
 
• Eject the simulation and Edit the feature 
• Click on Finish1 in the tree view and click on the Leads tab 
• Fill in the form exactly as shown 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Click Apply and then OK 
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• Run a Centerline simulation 
 

The tool is now arcing on and off the part smoothly. Short links are joined by loops. Longer 
links are still lifting off the job. We will now reduce the amount of time spent in the air by 
switching to Relative Plunge/Retract.  
  
• Eject the simulation and Edit the feature 
• Click on Finish1 in the tree view and click on the Milling tab 

Note: The surface finish is controlled by the scallop height value 
• Click on Retract/Plunge 
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• Fill in the form exactly as shown and click OK 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

• Click Apply and then OK 
• Run a Centerline simulation 

 
Relative plunge tells FeatureCAM that you wish to plunge at rapid down to the specified 
Plunge clearance above the next point to be cut rather than plunging at a reduced feedrate all 
the way from the Z rapid plane. This reduces the length of time spent on slow plunge moves. 
 
Relative retract instruct FeatureCAM to retract by only enough to maintain the specified 
clearance from the part when moving at rapid from one toolpath pass to the next. Another 
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name for this is Skimming as the tool skims above any obstacles rather than retracting all the 
way to the z rapid plane. 

Corner Across Finishing 
 
Along finishing works well on shallow areas of a part, however, where a corner runs down a 
steep area the strategy is less suitable as it will either be machining down the corner or when 
cutting it will be bringing the tool sideways into the remaining material at the bottom of the 
pass. In such cases it is better to use a Corner Across strategy where the tool clears the 
remaining material by beginning at the top of the steep area and “stitches” to and fro across 
the corner. The tool loading is thus reduced giving a good surface finish with a smaller risk of 
tool damage. 
 
• Eject the simulation 
• Edit the srf_mill3 feature 
• Click on Remachine in the part view and select Across as the Option 
• Click on Slopes tab and Select Vertical only and enter a Minimum 

surface slope of 30 
• On the Stock tab change the Overcut % to Zero 
• Click Apply and then OK 
• Run a Centerline simulation 

 
 
The tool stitches across the corner in such a way that each pass follows the surface normals of 
the intersecting surfaces at the point of contact of the tool. On a horizontal corner the place of 
the toolpath passes would be vertical, when the corner is vertical the toll will make passes in 
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the horizontal plane. Note how the plane of the tool passes varies smoothly with the changing 
angle of the surfaces being machined. 

Combo Along and Across Corner Finishing 
 
In the examples above we have seen how steep and shallow corners can be machined using 
Along and Across strategies respectively. By creating two operations and choosing 
appropriate slope angles we can machine all of the corners on a part. In order to make this 
easier FeatureCAM has another strategy which automatically combines the along and across 
strategies in a single toolpath. 
 
• Eject the simulation 
• Edit the srf_mill2 feature 
• Click on Remachine 
• On the Strategy tab select Combo Along and Across 
• On the Slopes tab, Click None 
• Click OK and simulate the toolpaths 

 
This has machined the shallow areas using an Along strategy and the steep areas using 
Across. This gives the optimum surface finish whilst protecting the tool in steep areas. The 
two parts of the toolpath meet exactly at the point where the slope angle changes from steep 
to shallow. Where the smoothness of the fillets are important it may be desirable to follow an 
Across or Combo toolpath with a Pencil operation to remove the scallops left where the tool 
has stitched across the corner. 
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• Turn on the features srf_mill1 and srf_mill2 in the part view 
• Edit the feature srf_mill2 
• On the Slopes tab select None 
• Click Apply and then OK 
• Reorder the toolpaths in the operation view so the pencil is last 
• Run a 3D simulation 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
• Turn on Tool colors in the Simulations options - General tab 
• Run a 3D simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



FeatureMILL3D                                                                                 Corner & Pencil Finishing 
 

16 Issue FeatureMILL3D 2012   

 
 
You can now clearly see the area where the Remachining has removed the excess stock. 

Corner Multi Pencil Finishing 
 
Multi Pencil finishing is a variation on Corner Along machining. The main difference is that 
the toolpaths are ordered in such a way as to minimize the number of times the tool lifts off 
the job. Successive passes are joined by smooth looping moves. The toolpath is best suited to 
parts with shallow corner areas and materials/tooling where the cutting direction is not 
important as it is not possible to control the cutting direction. 
 
• Eject the simulation 
• Uncheck srf_mill1 and srf_mill2 in the Part view 
• Edit the srf_mill3 feature 
• Click on Remachine in the part view and select Multi pencil as the Option 
• On the Slopes tab, Click Horizontal only and set the Maximum surface 

slope to 30 
• On the Stock tab set the Overcut % to 100 
• Click Apply and then OK 
• Run a Centreline simulation 

   

 
 
This toolpath is similar to the Along strategy except that it doesn’t lift off the job as much.  
The only disadvantage is that it alternates between climb and conventional milling.   
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Isoline Finish Machining 
Introduction 
 
Isoline machining is a finishing technique that machines each surface in a part individually. 
The tooling passes are aligned with the internal curves (isolines) that make up the surfaces. 
This often gives the user a greater degree of control over the cutting direction and surface 
finish than other methods. In this example, we shall machine a die for a jug. 
 
• Open the part Isoline.fm 
• Load the tool crib Isoline.fm_Tools_from_last_save 
• Select an Isometric view 

 
 

This part contains nine surfaces. Roughing strategies to clear out the bulk of the stock have 
already been set up. We will now create an isoline finishing strategy for each of the surfaces. 
 
In this case we only want to finish the curved surfaces. The flat top of the stock has been 
finished by a facing operation. We therefore do not need to include these upper flat surfaces 
in the list of surfaces to be machined. 
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• Select all of the surfaces except for the three flat surfaces 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Create a new surface milling feature 
• Check Choose a single operation 
• Click Next until you reach the New strategy page 
• Select Isoline 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Finish 
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• Click on finish1 and select the Tools tab 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

• Select a 0.1875” diameter ball nosed tool and press Apply 
• Click on the Milling tab and set the stepover to 0.025” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click Apply 
• Press Apply and then OK 
• Uncheck the operations face1 and srf_mill1 in the parts view 
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• Run a Centerline simulation 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The toolpaths should appear as in the picture above. Note how each toolpath follow the shape 
of its individual surface. We will now modify the order in which the surfaces are machined 
and direction in which they are cut. This is being done in order to give better cutting 
conditions in the narrow sections and a better surface finish overall.  
 
• Edit the feature 
• Click on Isoline in the tree view and select the Surface control tab 
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The surfaces are machined in the order in which they appear in the surface control list. 
Surfaces may be moved up or down the list by selecting them and then using the up and down 
arrows to the right of the list. 
 
• Using this method, place the surfaces into the order shown below 
 
 
 

• Click Apply and then OK 
• Run a Centerline simulation to see how the order in which the surfaces 

are machined has been changed 
 
We will now consider how to get the best surface finish and shortest machining time by 
changing the cutting directions from the defaults. The stepover set in Isoline machining is 
the maximum stepover. Where a surface is getting wider and narrower, the stepover will 
apply at the widest point on the surface. As the surface narrows, so will the stepover. This 
may result in a longer than necessary toolpath and over machining where the isolines are very 
close together.  For example on the jug body the stepover is varying between approximately 
0.025” and 0.010”. 
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• Edit the feature 
• Click on Isoline in the tree view and select the Surface control tab 
• Click on ig_shell9 in the surface control list 
 

 
 
 
 
 
The pair of arrows on each of the surfaces shows the surface normal and the direction of the 
first cut.  The surface normal arrow must point towards the side of the surface that you want 
to be machined. The direction arrow indicates  whether the first cut is to be along the 
surface or across and which corner the pass will start at. 

• Click on the Set isoline row/col button    and the Cut direction button 

 until the arrows on the jug body are aligned as shown below 
 
 
 
 
 
The first pass will now start in this corner 
and cut around the body of the jug 
instead of along. This will give a constant 
stepover. 
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• Repeat this process for ig_shell6, ig_shell7 and ig_shell8 aligning the 

cutting directions as shown below 

              
          ig_shell6        ig_shell7                    ig_shell8 
 
• Press Apply and then OK 
• Run a Centerline simulation to see the new cutting strategy 
 

 
 
• Check face1 and srf_mill 1 in the part view 
• Run a 3D simulation to see the surface finish 
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The surfaces are now being cut in the specified order and direction to give a good surface 
finish. You will note however that in some areas of the model the tool is cutting from the 
bottom up towards steep or vertical surfaces. We can remedy this by modifying the model by 
un-trimming and breaking surfaces into smaller pieces to improve the cutting conditions. 
 
We will now look briefly a one of the surfaces to see how this can be achieved. 
 
 
• Eject the simulation 
• Delete the feature srf_mill 2 in the part view 
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• Select the surface that makes up the body of the jug, ig_shell9 
• Hide everything else (use the Ctrl, Shift and U keys together) 
• From the View menu select Toolbars 
• Check the Advanced toolbar 

 
 
 

 
 
 
 
 
 
 
 
This raises the Advanced toolbar 
from which you can access the 
surface wizard. 
 
 
 
 

• Click OK 
• Click on the Surface wizard 
• Check From one surface 
• Check Untrim surface 
• Click Next 
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• Fill in the form as shown making sure that the correct surface is selected in 
the pulldown menu 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Preview 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FeatureCAM shows you a wireframe of how the surface will look after the trimming is 
removed. Note how the two cutaways where the fillets meet the body of the jug will be filled 
in. This will allow us to machine along the jug without getting multiple retracts. 
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• Click Finish 
 
Now that we have untrimmed the jug body the next step is to split it into two separate 
surfaces at its lowest point. This will allow us to machine each of the surfaces individually in 
a top down direction. 

 
• Click on the Surface wizard 
• Check From one surface 
• Check Split surface 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Next 
• Fill in the form as shown making sure that the correct surface is selected in 

the pulldown menu 
 

Note: as you check either Row or 
Column a blue curve will appear 
on the surface indicating the 
direction it will be split along as 
shown below. 
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We now need to indicate the particular point at which we want to split the surface. We do this 
by selecting an isoline position. If we select an existing isoline then the surface will split 
there. If we select in between isolines then FeatureCAM will first insert a new interpolated 
isoline at the indicated position and then split the surface along the new curve. 
 
• Take a Top view 
• Click on the Pick point button at the lower left of the form 
• Pick the centerline of the jug as indicated 

• Click Finish 
• Hide the surface ig_shell9 and then select the two new surfaces 
• Create a new surface milling feature 
• Check Choose a single operation and click Next 
• Check Isoline and click Finish 
• Click on Isoline in the tree view and select the Surface control tab 
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• Click on the Set isoline row/col button    and the Cut direction button 

 until the arrows on the jug body are aligned as shown below 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Press Apply and then OK 
• Uncheck face1 and srf_mill 1 in the part view 
• Run a Centerline simulation to see the new cutting strategy 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The tool is now starting on the top edge of the jug body, cutting along the part and stepping 
over from the top towards the bottom. 
 
• As an exercise use Untrim surface and Split surface to prepare the rest of 

the model for optimum cutting conditions and minimum number of retracts 
• Once this is complete prepare further Isoline toolpaths to finish the part 
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Radial and 2D Spiral Finishing 
Introduction 
FeatureCAM has three strategies which are created by the downward projection of a 
pattern; these are Parallel, Radial, and Spiral. As we have already looked at Parallel in 
some detail, this module will just deal with Radial and 2D Spiral. 

Radial Finish Machining 
 
In radial finishing, the pattern from which the toolpath is created consists of a series of 
straight lines which radiate out from a center point. The passes are equally spaced at a user-
defined angle. The image below shows a radial pattern viewed from above and the resulting 
toolpath after projection onto a set of surfaces. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Open the file Doofa.fm 
• Select an Isometric view 

 
 

One advantage of pattern machining 
strategies over others is that they are 
quicker to calculate. This is because 
FeatureCAM already knows the 2D 
(XY) path that the tool center is 
going to follow; it then just has to 
calculate the required Z height to 
keep the tool in contact with the part. 
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The file already contains a Z Level roughing and an Horizontal & Vertical finishing toolpath. 
We will now run a 3D RapidCut simulation to see the result. 
 
• Run a 3D RapidCut simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The part has been finished with a 0.025” stepover. It can be seen that the machining marks on 
the surface are fairly obvious so although the part has been machined accurately it may not be 
aesthetically pleasing. We will now look at using a radial toolpath to provide a better finish 
on the upper surfaces. 
 
• Eject the simulation 
• Delete the feature srf_mill1, or simply Uncheck it in the Part View. 
• Box-select all the faces and create a new surface milling feature 
• Choose a single operation 
• On the New strategy page select Radial 
• Click Finish 
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• Click on the finish1 in the tree view and select the Milling tab 
• Set the Center point to pt(0,0,0) as shown 
(You can do this either by typing or using the pick button and picking off the model). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click Apply then Preview 
• Play the simulation 

 

 
 
You will notice a number of things in the simulation. In the left image above, you can see that 
the toolpaths are far apart at the outside of the model and close together in the center. This 
would give a poor surface finish on the outside edges and possibly overmachine the center. In 
the right view, you can see that the tool is machining too far down the side of the part, we 
want to machine just the upper, less steep surfaces. 
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We will now limit the area to be machined by setting an inside and outside radius limit on the 
toolpath. This will leave an area in the center of the part which is not machined; we will come 
back and machine it using a different strategy later. 
 
• Eject the simulation 
• Edit the feature srf_mill2 
• Click on finish1 and select the Milling tab 
• Set the Radius start to 1.2” and the Radius end to 1.675” 
• Change the Stepover angle to 1 degree 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click Apply and then OK 
• Preview these changes. 
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The toolpath is now restricted to the area between the Radius start and the Radius end. The 
first pass will start at the Radius start and cut towards the Radius end.  
If the toolpath is set cut uni-directionally, this allows us to control whether the tool cuts 
outside in or inside out. For example, if the Radius start is larger than the Radius end, the 
tool will start at the outside of the part and cut inwards.  
 
• Eject the Simulation 
• Edit the feature 
• On the Milling tab click Direction 
• Select Unidirectional 

 
 
Note that you can also control whether the tool passes go around the part in a clockwise or 
counter clockwise direction 
 
• Click OK, then Apply and then OK 
• Run a Centerline simulation 
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The tool is now cutting the part in a single direction, plunging at the Radius start and 
then cutting in an outward direction to the Radius end. 

 
• Eject the Simulation 
• Edit the feature 
• On the Milling tab click Direction 
• Select Bidirectional and click OK 
• Set the Angle start to 0 and the Angle end to 120 degrees 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click 

Apply and then OK 
• Run a Centerline simulation 
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The tool is starting at an angle of zero (along the X axis) and cutting around the part until 
it reaches an angle of 120 degrees in the XY plane. 

 
• Eject the Simulation 
• Edit the feature 
• Select the Milling tab 
• Set the Angle start to 120 degrees and the Angle end to Zero 
• Click Apply and then OK 
• Run a Centerline simulation 
 
Note how the tool now starts at the 120 degree position and then works back to the X axis. 
 
• Eject the Simulation 
• Edit the feature 
• Select the Milling tab 
• Unset the Angle start and the Angle end 
• Click Apply and then OK 
• Check the roughing operation in the part view 
• Run a 3D RapidCut simulation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The toolpath is machining across the fillet and surrounding surfaces giving a superior surface 
finish to that we were originally getting with the Horizontal and Vertical finishing toolpath. 
We will now machine the center portion of the part using a different technique. 
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2D Spiral Finishing 
 
We will be using a 2D spiral toolpath next. This is best suited to surfaces with a fairly 
constant slope as it uses a 2D stepover. On surfaces with a combination of steep and shallow 
surfaces 2D Spiral will give a poor finish on the steep areas. We will be using a circle as a 
boundary, this will be created next. 
 
• Eject the simulation 
• Create a Circle with a diameter of 1.25 inches at the origin (0,0,0) 
• Double click on the feature srf_mill2 to open its properties 
• Select the Process tab 
• Click Add new operation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select a 2D Spiral strategy and click Finish 
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• Select the spiral2d operation and then the Stock tab 
• Check Select curves for boundaries then click Curve options 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Check 3D pocket then click on Boundaries 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
• Select the circle circ4 and then click OK, then OK again (your circle 

number could be different) 
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• Select finish2 and then the Milling tab 
• Change the Stepover to 0.025” 
• Click Apply and then Preview 
• Run the simulation 
 

 
The circle is offset repeatedly by the specified 0.025” stepover to create a pattern of 
concentric circles. This pattern is then projected down on to the part to make the toolpath. 

 
• Eject the simulation 
• Run a Centerline simulation 
 
 
 
 
 
 
 
 
The two toolpaths overlap by 
0.05”, we set this by the Start 
radius of the radial toolpath and 
the size of the circle we used for 
the 2D Spiral. 
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• Turn on the roughing operation 
• Run a 3D RapidCut simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The surface finish is generally better than that which we originally got with Horizontal and 
Vertical finishing. There are a couple of areas where we could make further improvements. 
Firstly, there is a witness mark where the tool is stepping between each pass of the 2D Spiral. 
Secondly, in the trough around the center, there are some undesirable marks where the 
contact point is changing from one side of the tool to the other. 
 
• Eject the simulation and edit the 2D Spiral feature 
• Set the Stepover rapid distance to 0.01” 

• 
Use a relative plunge and retract as shown 
 

By setting the Stepover rapid distance smaller than the toolpath stepover we are forcing the 
tool to lift off at the end of every pass. The relative plunge and retract minimize the amount 
of time spent in the air. 
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• As an exercise, create a new radial toolpath with a start radius of 0.6, end 

radius 0.95, angle stepover 1.5 degrees using a 0.25” ball nose cutter. 
 
• Run a 3D RapidCut simulation 
 
 
 

 
 

By causing the tool to lift off 
between passes we have removed 
the witness marks and the second 
radial toolpath has improved the 
finish in the trough area. 
 
 
 
 
 
 
 
 
 
 
• As a final exercise, import the file Clover.igs and use it to engrave onto the 

centre of the part as shown with a recess around it 
 
Hint: Use a 2D Spiral 
toolpath with a small 
cutter and a negative 
leave allowance for the 
clover leaf.  
 
Modify the existing, 
second radial toolpath to 
produce the ditch.  
 
If you get stuck take a 
look at the file: 
 
 Doofa_Finished.fm 
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Flowline Finish Machining 
Introduction 
In this module you will be introduced to the Flowline machining strategy. In flowline a guide 
surface is used to produce toolpaths across multiple surfaces. Internally FeatureCAM 
produces an Isoline toolpath on the guide surface, this it then projected along the guide 
surface normals onto the surfaces that are to be machined. The flowline technique has many 
applications.  As long as you can create a single surface that mimics that shape of the 
toolpaths you desire, flowline toolpaths are applicable.   

Flowline Example 
 
This model shown below is the bottom of a blow mold for a soda bottle.  
 
• Open the part Blow_Mold.fm  
• Select the tool crib Blow_Mold.fm_Tools_from_last_save 
• Select an Isometric view 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The inner part of the mold contains many surfaces. We want to create a toolpath which will 
smoothly machine over all of them.  
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• Run a Centerline simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The present Z Level Interleaved finishing toolpath is fragmented with many retracts. The 
toolpath shape may lead to undesirable machining witness marks on the part. We will now 
see how a flowline toolpath can give a much better result. 
 
We first need to create a surface to use as the flowline guide surface.  We already have a 
curve in the center of the pocket.  This will be spun around the Z axis to form a surface of 
revolution. We will now open up the Surface Wizard to model this surface. 
 
• From the View menu select Toolbars 
• Check the Advanced toolbar 

 
 

 
 
 
 
 
 
This raises the Advanced toolbar from 
which you can access the surface wizard. 
 
 
 
 
 

• Click OK 
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• Click on the Surface wizard 
• Check From Curve 
• Check Surface of revolution 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Click Next 
• Fill in the form exactly as below (be sure to name the new surface “Guide”) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click Finish 
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The new, hemispherical control surface is positioned in the center of the pocket. 
 
• Edit the feature srf_mill1 and select the Process tab 
• Uncheck the Z Level operation 
• Click Add new operation 

 
 
 
 
 
 
 

 
 
 
 
 
 
• Select Flowline 
• Click Finish 
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• Click on Flowline and select Surface Control 
• From the pulldown select guide 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Ensure that the machining direction arrows appear as shown below, if not 

use the Set isoline row/column, Cut direction and Switch machining 
side buttons (top two and bottommost buttons on the right of the form) 

 
 
 
 
 
 
The two arrows should be at 
the top edge of the guide 
surface. 
 
The surface normal arrow 
should be pointing outwards 
towards the surfaces to be 
machined. 
 
The cut direction arrow 
should be pointing around 
the guide surface so as to 
create a climb milling cut.  
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• Click Apply 
• Click on finish2 and select the Tools tab 
• Select a 0.25” Ball end mill 
• Select the Milling tab 
• Set the Stepover to be 0.025” 
•  Click Apply and OK 
• Hide the control surface 
• Run a centerline simulation 

 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The flowline toolpath is machining across all of the surfaces with a single un-fragmented 
toolpath. There are no retracts during the cutting operation and the stepover is much more 
even and less dependent upon the slope of the surfaces being machined. 
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Undercut Flowline Machining 
 
The use of flowline machining together with a lollipop or other side cutter allows the user to 
machine undercut areas without the use of 5 axis strategies. In this example flowline 
machining will be used to machine a port on a manifold, achieving an even surface finish this 
difficult undercut part. By machining along the port, the machining cusps are aligned with the 
gas flow direction giving better flow properties and ease of polishing. 
 
• Open the part Manifold_Start.fm  
• Select the tool crib Tools 
• Select an Isometric view 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The part has been positioned so that the undercut is as small as possible. We are going to 
machine the port which is highlighted in the image above. The first step is to create the 
flowline control surface from the circle and centerline curve provided. 
 
• Raise the Advanced toolbar (as described earlier) 
• Click on the Surface Wizard 
 
 
• On the surface wizard check From curves and Swept surface 
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• Press Next 
• Change the Surface name to Control_surface 
• Set the Axis to ig_25 

• Click the curve selector next to Cross section  
• Select the circle at the top center of the port (circ7) 
• Check Sweep from other end 

 
 
 
 
 
 
 
 

 
• Press Preview 
 
 
 
The preview surface should appear down the 
center of the port as shown. 
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• Press Finish 
• Select the 8 surfaces that form the inside of the port 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Create a Surface milling feature and press Next 
• Check Choose a single operation and press Next 
• Check Flowline then press Finish 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Edit the Feature 
• Click on Flowline and select the Surface control tab 
• From the pulldown select the surface Control_Surface 
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• Use the Isoline set row/column    and Switch machining side    
buttons to get the machining direction arrows pointing down and out from 
the control surface as shown above left 

• Click on finish1 
• Select the Tool tab 
• Select the tooling group Side Mill 
• Select the tool 3/16_lollipop 
• Click New tool 
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We need a larger diameter tool so that the neck and shank of the tool will clear the sides of 
the port. 

 
• Fill in the form as shown then click Apply and OK 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click on the Milling tab 
• Set the Stepover to 0.010” 
• Click on the Leads tab 
• Fill in the form as shown 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Apply and then OK 
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• Run a Centerline simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The port has now been finish machined. By using flowline machining with a control surface 
that follows the form of the port we have achieved an even stepover. Note how the lead-out 
move ensures that the tool clears the job on the retract move. 
 
• Eject the simulation 
• From the Options menu select Simulation 
• On the General tab check Show holder 
• Select the 2D/3D Shaded tab 
• Check Translucent part 
• Click Apply and then OK 
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• Run a 3D simulation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The tool neck and shank are missing the part while machining the undercut, however the tool 
and shank length may be giving too much flexibility causing deflection and chatter. 
 
• As an exercise try cutting the part with the tool machining around the bore 

rather than up and down. Also try changing the tool shank and neck 
diameters and lengths to find values which give the optimum rigidity while 
not colliding with the part. 
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Between 2 Curves Finishing 
Introduction 
 
This strategy generates a toolpath between two user-defined curves. The stepover is along the 
surface in a similar manner to 3D Spiral machining. The curves can be used to define the 
location of the center of the tool or its point of contact on the part. The toolpath morphs from 
the shape of the first curve to the shape of the second with a user defined stepover. Both of 
the curves must be either open or closed; it is not possible to mix open and closed curves. 

Between 2 Curves Finish Machining 
 
• Open the part Two_Curves.fm  

 
• Select an Isometric view 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

This part has a smooth, sweeping curved area. If this were a single surface, an Isoline strategy 
would be ideal. In this case however, the area is made up of many separate faces making it 
impractical to use Isoline. A similar result may be obtained by using the Between 2 curves 
strategy. 
There are two curves in the part (top and bottom) which follow the upper and lower edges of 
the area to be machined. These are positioned above the top of the stock so they can be easily 
seen. In practice, the Z position of the curves is unimportant. 
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• Select all of the surfaces 
• Create a new Surface milling operation 
• Click Choose a single operation and click Next 
• Select Between 2 curves and click Next 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
• Select the curves top and bottom in the pulldown menus as shown 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

• Click Finish 
• Click on finish1 and select the Milling tab 
• Set the Stepover to 0.1” 
 
 
 
 
• Run a Centerline simulation 
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The tool is following a smooth flowing path which starts off by following the first curve (top) 
and then gradually transforms its shape until it meets the second curve (bottom). 

 
• Eject the simulation 
• Edit the feature 
• Select the strategy tab and choose Across curves 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Click Apply and then OK 
 
 
 
• Run a Centerline simulation 
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The tool is now “Stitching” to and fro between the two curves. As the length of the curves is 
very different the toolpaths are far apart at the upper edge and close together at the lower 
edge. Normally the “Across” option would only be used where the curves were of similar 
length and curvature. 
 
• Eject the simulation 

 
• As an exercise make a new curve part way between top and bottom. Use 

this to make two new Between 2 curves toolpaths using across for the 
upper portion and along for the lower 
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3-Axis Swarf Finishing 
Introduction 
Swarf machining is normally a 5-Axis machining strategy where the part is finished using the 
side of the tool. The advantage is that a surface can be finished with a single pass giving a 
shorter machining time and a superior surface finish. Swarf machining may also be used as a 
3-Axis machining strategy. Parts with a vertical wall or with a constant angle taper can be 
finished in a single pass by using an appropriate tool.  
 
Where the side walls of the part have a variable taper it is possible to machine using a ball 
nosed cutter with multiple passes. In this module, we will first look at a part that can be 
machined with a single pass and then at a more complex part that requires multiple passes. 

3-Axis Swarf 
The part used in this example is a simple flange casting which requires the inside and outside 
edges finishing. The outside edge is vertical and the inside edge has a constant 5 degree taper. 
As the edge to be finished is a 3D profile, it would not be simple to create a 2.5D side feature 
to finish the part.  
 
• Open the part Swarf.fm  
• Select an Isometric view 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
As you can see from the side view, the top and bottom edges of the part are curved. 
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First of all we shall machine the outer, vertical edge of the part using a flat endmill. This 
would be possible using a side feature but the tool would be going all the way to the bottom 
of the part throughout the side finish pass. This would require a long tool. 
 
• Select the surfaces that make up the outer wall of the part 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Create a new Surface milling operation 
• Click Choose a single operation and click Next 
• Select Swarf and click Finish 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click OK 
• Slow down the simulation speed 
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• Run a Centerline simulation 

 
The tool is machining around the part following the lower edge of the selected surfaces.  
 
• Run a 3D simulation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The casting is slightly larger than the finished part, this means that a small lip of excess 
material is felt after the finishing pass. We need to make the tool tip move slightly past the 
lower edge of the part to ensure that it cleans up the edge. 
 
• Eject the simulation 
• Edit the feature and select the Milling tab 
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• Set the Axial Offset to -0.05”. (This tells the tool to go past the edge by 0.05”) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Run a 3D simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The tool now projects past the lower edges of the surfaces selected for machining by 0.05” so 
that a clean finish results. It will be noted that the tool is approaching the part by plunging 
vertically down the face that is to be finished. This could result in a witness mark. We will 
now modify the toolpath to ramp into the part with a horizontal arc. 
 
• Eject the simulation 
• Edit the feature and select the Leads tab 
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• Select a Horizontal arc Lead in and Lead out as shown below 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Apply and then OK 
• Take a Top View 
• Run a Centerline simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The tool is now ramping smoothly on and off the part. 
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• Eject the simulation 
 

We will now machine the inside edge of the part which has a 5 degree taper. 
 
• Select the inside surface of the part 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Create a new Surface milling operation 
• Click Choose a single operation and click Next 
• Select Swarf and click Finish  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click on finish1 and select the Tools tab 
 



FeatureMILL3D                                                                                      3-Axis Swarf Finishing 

      Issue FeatureMILL3D 2012                                                     7 

 
 
 
• Select a long reach 0.5” Flat endmill and then select New tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Fill in the form exactly as shown below 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Apply and OK 
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• Edit the feature and select the Milling tab 
• Set the Axial Offset to -0.05” (This tells the tool to go past the edge by 0.05”) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Select the Leads tab 
• Select a Horizontal arc Lead in and Lead out as shown below 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click Apply and then OK 
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• Run a 3D Simulation 

 
 
The part is now finished; note how the tool tracks up and down in Z while following the edge 
of the constant tapered part. This would not be possible with a 2.5D Side feature.  
 
We shall now look at a part that requires multiple passes for finishing. 
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3-Axis Swarf – Multiple passes 
 
This part has a varying radius around the corners. It could be finished by a 5-Axis swarf 
toolpath in a single pass. If we use a 3-Axis swarf toolpath then multiple passes will be 
required. 
 
• Open the part Multi_Swarf.fm 
• Select the tool crib Multi_Swarf.fm_Tools_from_last_save 
• Select an Isometric view 
 
 
 
 
 
 
 
 
 
 
 
The part contains a Z Level finish toolpath for the tapered surfaces, we will now run a 3D 
simulation to see the result of this toolpath. 
 
• Run a Centerline simulation then a 3D simulation 

 
 
 
The shallow slopes at the 
top and bottom edges of the 
part are causing the tool to 
lift off many times. This not 
only results in wasted air 
moves but also gives a poor 
finish at both edges of the 
part. 
 
 
 
• Eject the simulation 
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• Edit the feature 
• Select the Process tab and uncheck the Z Level operation 
• Click on Add new operation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Select a Swarf operation and click Finish 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click on finish2 and select the Tools tab 
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• Select a 0.375” Ball nosed endmill 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Apply and then select the Milling tab 
• Check Multiple cuts 
• Click on the Multicut strategy pulldown 
• Select Merge 
• Set the Z Increment to 0.050” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click Apply and then OK 
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• Run a Centerline simulation then a 3D simulation 

 
The toolpath now “Merges” from a single unbroken pass around the top edge of the part to a 
single pass around the bottom edge. The stepover is adjusted to give a whole number of 
passes. The specified stepover of 0.05” is applied at the widest part of the surfaces being 
machined and adjusted proportionately depending upon the width of the part at each point. If 
you look at the left end of the part where the surfaces are at their narrowest you will see that 
the toolpaths are bunching together at that point. 
 

 
 
  
• As an exercise try the three different options for multiple cuts – Merge, 

Offset top down and Offset bottom up. 
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4-Axis Rotary Finish Machining 
Overview 
In 4th Axis or Rotary machining, a part is mounted in a rotary chuck which rotates to allow 
access to areas of the part not normally reachable by 3 axis machining. In this example, we 
will be finish machining a component which would be difficult to machine using a 3-axis 
setup due to its length and small inside radii. 

4-Axis Finishing 
 
• Open a new Inch milling document 
• Fill in the stock Dimensions form as shown below 
 

 
 
• Press Finish 
• On the Stock properties form select the Indexing tab 
 
We need to tell FeatureCAM which axis our machine will be using for rotational moves. In 
this case we are setting up to rotate around the X axis. In general, there are three possible 
rotary axes. These are called the A, B and C axes. A 4-Axis machine will have the normal 
X,Y and Z linear movement axes plus one rotary axis. Depending upon the machine, this may 
be an A axis (rotates around X), a B axis (rotates around Y)or a C axis (rotates around Z). 
The most common 4-Axis machine configuration is XYZ plus A axes. 
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• Fill in the form as shown below 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Here we have set up the stock to rotate about a rotary X or A axis. 
 
• Press Apply and then OK 
• Import the model Spindle.igs 
• Check Accept the imported data “as is” and exit the wizard 
• Press Finish 
• Select an Isometric view 
 

 
 

The stock and component are aligned with the X axis. In the stock properties form we told 
FeatureMILL3D that we were going to use 4th Axis Positioning and were going to rotate 
around the X axis. We now need to create a surface milling feature. 
 
• Select all of the surfaces 
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• Create a new surface milling feature and Next 
• Check Choose a single operation and press Next 
 
As you will see there is now a new option on the New strategy form – Four Axis 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Check Four Axis Rotary and press Next 
• Fill in the form as shown below 

 
 
 

 
The Y offset allows the tool to 
be offset away from the default 
Y zero position. This allows the 
user to prevent the tool from 
center cutting. 
 
 
 
• Press Finish 
• Press OK 
 
 
 
 
 
 
 

• From the main menu select Manufacturing then Post Process 
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• Set the Tool change location Z to 12” 
• Click on the Browse button and select the HaasVF-4axis post from: 

 
C:/Program Files/FeatureCAM/M-Library/4thxs 
 

• Press OK 
• Run a Centerline simulation 
 

 
 
 
 
It can be seen that the toolpath 
is rolling over the ends of the 
part. We need to limit the 
extents of the toolpath to give 
the desired result. 
 
 
 
 
 
• Eject the simulation 
• Edit the feature 
• Click on finish1 in the tree view 
• Select the Milling tab 
• Click on Index start coordinate and set the value to 0 
• Click on Index end coordinate and set the value to 4.35 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Click Apply and then OK 
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• Run a centerline simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The toolpath is now limited to the portion of the feature between X 0.0” and X 4.35”. It is 
important to remember that the X values given are from the setup origin to the center of the 
tool. It is also possible to apply an angular limit to the toolpath allowing the user to machine a 
selected area of the feature. 
 
• Edit the feature 
• Click on finish1 in the tree view 
• Select the Milling tab 
• Click on Angle start and set the value to 0 
• Click on Angle end and set the value to 120 
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• Click Apply and then OK 
 
• Run a centerline simulation 
• Select a view from the Left 
 
 
 
It can be seen that only one third of the part 
has been machined. The start angle of 0 is 
aligned with the Z axis, and the end angle 
of 120 is in the clockwise direction around 
the X axis. 
 
We will now look at the Circular and 
Spiral options of 4 axis machining. 
 
 
 
• Edit the feature 
• Click on finish1 in the tree view 
• Select the Milling tab 
• Click on Angle start and then Unset 
• Click on Angle end and then Unset and Apply 
• Click on fouraxis in the tree view 
• Check the Circular option on the Strategy tab 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Click Apply and then OK 
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• Select an Isometric view 
• Move the Simulation speed slider to the left to slow down the simulation 
• Run a centerline simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This time the toolpath runs around the part instead of along it. The direction of rotation 
reverses on each pass. The tool steps over on the surface of the part between passes.  
 
• Edit the feature 
• Click on fouraxis in the tree view 
• Check the Spiral option on the Strategy tab 
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• Click Apply and then OK 
• Select an Isometric view 
• Run a centerline simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
With the spiral option selected the toolpath follows a continuous spiral along the part. This 
will give a better surface finish than the circular option as there will be no dwell marks from 
stepover moves. The strategy will require a machine tool with a rotary axis which can rotate 
continually with no axis limit. We will now look at controlling the cutting direction. 
 
• Edit the feature 
• Click on finish1 in the tree view 
• Select the Milling tab 
• Click on Index start and set the value to 4.35” 
• Click on Index end and set the value to 0” 
• Click Apply and then OK 
• Run a centerline simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

It can be seen that the X direction of cutting has now been reversed. 
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• Edit the feature 
• Click on fouraxis in the tree view 
• Set the Y Offset to be 0.25” 
• Click Apply and then OK 
• Edit the stock properties and change to a User defined stock 

 

 
 

• Select solid1  
• Select a Right view 
• Run a 3D simulation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
It can be seen that the cutter is now offset from the rotary axis by 0.25” in the Y direction. 
This means that the tool is not center cutting. This will create better cutting conditions giving 
improved surface finish and tool life. 



Wall tolerance for Z-Level 
Overview 
 

FeatureCAM decides whether a wall is vertical or not based on a tolerance. If the horizontal 
distance between the top and bottom edges of the wall is greater than the tolerance it is 
regarded as not being vertical and will be machined. There are two tolerances used, the "Part 
boundary tolerance" (PBT) and the "Wall tolerance". These are accessed through the 
Advanced button next to "Don't roll over edges at all" on the edges menu (please see attached 
image).  

 

If "Use separate wall tolerance" is not checked then the verticality of the walls is based solely 
on the PBT.  If the checkbox is marked then the PBT is used to assess the overall part 
boundary and the wall tolerance is used to assess whether walls are vertical or not. This 
allows the user to relax the tolerance for walls (so that more areas are seen as vertical) 
without affecting the overall quality of the part boundary. 
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